
Footnotes, Bibliography, and Zotero: A Guide 

 

The Importance of Bibliography 
Academic research involves understanding what others have discovered and 

building upon their work to add new insights. No one can start entirely from scratch. 

Before embarking on any research, it is essential to examine what others have 

already done in the field. Properly using and citing sources is one of the most 

fundamental skills in scholarly writing. 

 

Why You Must Cite Sources 

There are several reasons to cite sources accurately. The most important is to avoid 

plagiarism, but citations also demonstrate the scholarly community you engage with 

and reveal the quality of your research. A well-constructed bibliography shows 

readers the intellectual traditions and conversations that informed your work. 

 

To Avoid Plagiarism 

The primary reason for citing sources is to give credit to the original authors. Using 

another person's ideas or words without acknowledgment constitutes plagiarism, 

which is considered the most serious academic offense. Accuracy and honesty in 

attribution are the fundamental obligations of any scholar. 

 

As an Index of Your Research 

A bibliography also serves as a concentrated index of your scholarly reading. 

Editors, peer reviewers, and readers often examine a paper's bibliography before 

reading the text itself, because it reveals the author's intellectual background and the 

conversations in which the work participates. 

 

To Acknowledge Your Scholarly Community 

The authors you cite are your academic conversation partners. Whether you agree 

with them, build on them, or critique them, they have shaped your thinking, and 

acknowledging them is a form of scholarly respect. 

 

Avoiding Plagiarism 

Plagiarism means taking another person's work—in whole or in part—and presenting 

it as your own without permission or acknowledgment. It is treated primarily as an 

ethical and moral violation in academia. 



 

Plagiarism vs. Imitation and Homage 

Plagiarism differs from imitation. Imitation involves recreating something in your own 

manner, while parody (Parody) borrows from an original source but acknowledges it 

and transforms it satirically. Homage (hommage) similarly imitates specific scenes or 

lines as an expression of respect for another artist’s work. Both are distinguished 

from plagiarism by their transparent acknowledgment of the source. 

 

Plagiarism Screening Guidelines 

The following guidelines, based on both Korean Ministry of Education standards 

(2008) and American academic norms, identify four situations in which citation is 

required: 

 

Six or More Consecutive Words Match 

If six or more consecutive words from a source appear in your text, you must place 

them in quotation marks and cite the source. 

 

Paraphrase with the Same Meaning 

Even when the wording is changed to your own words, if the essential meaning is 

borrowed, you must cite the source. Quotation marks are not required, but the 

citation is. 

 

Identical or Essentially Similar Data or Claims 

When using another author’s data, findings, or core propositions, citation is required 

even without quotation marks. If you borrow a specialized term, you may place it in 

quotation marks. 

 

Self-Plagiarism 

Reusing a substantial portion of your own previously published work in a new piece 

without acknowledgment is called self-plagiarism. Even your own prior work must be 

cited if it has been published elsewhere. 

 

Citation and Bibliography Styles 
Several internationally recognized citation systems exist, each used in different 

disciplines. American citation styles have become increasingly influential worldwide. 

 

Major Citation Styles 

The major American citation styles include APA (American Psychological 



Association), Chicago/Turabian, Harvard, MLA, and ACS. The Chicago Manual of 

Style, published by The University of Chicago Press, is one of the most authoritative 

guides. It is divided into two main systems: the Humanities Style (notes and 

bibliography) and the Social Science Style (author–date). The Turabian style is 

identical to the Chicago Humanities Style. Unless otherwise specified by your 

instructor, GMU uses Turabian (Chicago Humanities Style) as its standard. 

 

General Bibliography Formatting Principles 

The following principles apply to bibliography formatting in English-language 

academic writing: 

 

1. Use only characters available on a standard keyboard to ensure compatibility 

across different word processors and computer systems. 

 

2. In English-style citations, enclose article titles in quotation marks and format book 

titles in italics. The older practice of underlining book titles is no longer used. 

 

3. In a bibliography entry, for English-language sources the author’s last name is 

listed first; in footnotes, the first name comes first. 

 

TURABIAN (Chicago Humanities Style): Bibliography Formatting 

Note that the format for bibliography entries differs from footnote format. The main 

differences are: (a) bibliography entries use periods to separate elements, while 

footnotes use commas; (b) in bibliography entries, the author’s last name comes 

first. 

 

Rules for Turabian Bibliography 

1. Article titles go in quotation marks; book titles are in italics. Underlining is 

obsolete. 

2. In bibliography entries, the author’s last name is written first. In footnotes, first 

name comes first. 

3. If multiple works by the same author follow each other, subsequent entries 

may use eight underscores in place of the name, though writing the name 

each time is now more common. 

4. No blank lines between bibliography entries. 

5. Entries are sorted alphabetically by author’s last name. 

6. Punctuation (commas, periods) must be exact; no comma before a 

parenthesis. 

7. Bibliography entries use periods between elements; footnotes use commas. 

8. For journal articles: in footnotes, write (38 (1996): 11-18) with a space after 

the colon; in the bibliography list, omit the space (38 (1996):11-18). 



9. When a single bibliography entry runs to a second line, indent the second and 

subsequent lines 0.5 inch from the left margin (hanging indent). This must be 

set using the paragraph indent tool, not the spacebar. 

 

Turabian Bibliography Examples 

 

(Encyclopedia/Reference) 

Encyclopedia of Historical Science, 2nd ed. “Calvinism” by Nancy Ring 

Brenner. 

Encyclopedia of Historical Science, 2nd ed. “Whig Interpretation of History” by 

Rudolph Klein. 

 

(Newspaper/Weekly Magazine) 

“Historians at War Again.” Los Angeles Dispatch, January 14, 1969. 

 

(Single-Author Book) 

Parton, Norman. Ancient and Modern Thinking. London: Fernival & Ashwood, 

1956. 

 

(Journal Article) 

Roland, Cleveland. “Machiavelli and Modern History.” Journal of the 

Philosophy of History 14 (February 1949):46-60. 

 

(Same Author, Multiple Works) 

Stanforth, Charles. Cyclical Theory in Arnold Toynbee. London: Greath & 

Sons, 1950. 

Stanforth, Charles. The Study of History. New York: Crown, 1961. 

 

(Edited Volume, Multiple Editors) 

Arnold, Michelle & Mary Swope, eds. New Trends in Historiography. 

Philadelphia: Claxton, 1972. 

 

(Internet Source: Author. Date accessed. Title. URL. Publisher/Webmaster. 

Language.) 

Fayetteville State University (29 March 2006). Mentoring program survey: 

Student/Protégé. 

http://www.uncfsu.edu/univcoll/mentoring/mentoringsurveystdnt.htm: 

Fayetteville State University. English. 

 

(Unpublished Work: Author. Title. Place. Year.) 

Kim, Hyunwan. “Library Information Lecture Notes.” Grace University, 2012. 

 



Turabian Footnote Examples 

Footnote format differs from bibliography format in several ways: elements are 

separated by commas (not periods); the author’s first name comes first; and 

publication details are enclosed in parentheses. The following examples illustrate 

proper footnote formatting. Numbers represent footnote numbers; text in (( )) is 

explanatory only and does not appear in actual footnotes. 

 

Footnotes Used Once 

1. Indent the footnote number 0.5 inch; align the remaining text to the left 

margin. 

2. All elements (author name, title, publisher details, year) are separated by 

commas. 

3. Publication details (city: publisher, year) are enclosed in parentheses. 

4. In English references, capitalize properly: articles and prepositions in titles are 

lowercase unless they are the first word. 

5. For a single page citation, use lowercase p.; for multiple pages, use pp. For 

journal articles, omit p./pp. 

6. In footnotes (unlike bibliography), the author’s first name comes first. 

 

1 Stanford E. Lehmberg, “Early Tudor Parliamentary Procedure: 

Provisos in the Legislation of the Reformation Parliament,” English Historical 

Review 34 (January 1970): 2-3. ((Journal article, more than one page)) 

2 Crane Brinton, A Decade of Revolution 1789-1799 (New York: Harper 

and Brothers, 1934), pp. 18-22. ((Single-author book)) 

3 T. W. Wallbank and A. M. Taylor, Civilization Past and Present, 2 

vols., rev. ed. (Chicago: Scott, Foresman, 1954), v. 2, pp. 104-117. ((Multiple 

authors)) 

4 Eugene C. Black, ed., Posture of Europe 1815-1940 (London: Dorsey 

Press, 1964), p. 102. ((Edited volume)) 

5 “America’s Interest in the Cuban Economy,” News Review (January 

20, 1936), p. 9. ((Newspaper/magazine article)) 

 

Subsequent Citations of the Same Source 

When a source is cited again after its first full citation, use only the author’s last 

name and the page number. “Ibid.” and “op. cit.” are no longer used. 

 

1 Charles Stanforth, The Study of History (New York: Crown, 1961), pp. 

42, 122-127. ((Book, first citation)) 

2 Cleveland Roland, “Machiavelli and Modern History,” Journal of the 

Philosophy of History 14 (February 1949): 49. ((Article, first citation)) 

3 Encyclopedia of Historical Science, 2nd ed., “Whig Interpretation of 

History,” by Rudolph Klein. ((Encyclopedia, no page needed)) 



4 Charles Stanforth, Cyclical Theory in Arnold Toynbee (London: 

Greath & Sons, 1950), p. 42. This source treats a specific topic in detail, while 

Norman Parton, Ancient and Modern Thinking (London: Fernival & Ashwood, 

1956), pp. 98-106, addresses the broader subject more generally. 

((Supplementary note)) 

5 “Historians at War Again,” Los Angeles Dispatch, (January 14, 1969), 

sec. B, p. 2. ((Newspaper article)) 

6 Michelle Arnold and Dana Swope, eds., New Trends in 

Historiography (Philadelphia: Claxton, 1972), p. 104. ((Edited volume)) 

7 Stanforth, Cyclical Theory, p. 14. ((Different work by same author, 

subsequent citation)) 

8 Roland, p. 50. ((Subsequent citation, same author and work)) 

9 (29 March 2006). Mentoring program survey: Student/Protégé, 

http://www.uncfsu.edu/univcoll/mentoring/mentoringsurveystdnt.htm: 

Fayetteville State University. English. ((Internet source)) 

 

APA Citation Style 

The APA style (American Psychological Association) is used primarily in the social 

sciences. It is equivalent to the Chicago Social Science Style. The key differences 

from Turabian are: 

 

1. In the bibliography/reference list, APA places the publication year 

immediately after the author’s name. Turabian places it at the end. 

 

2. APA does not use footnotes. Instead, short in-text citations (author, year, 

page) appear in parentheses in the body of the text. Explanatory notes, if 

needed, are placed as endnotes. Turabian uses footnotes at the bottom of 

each page. 

 

3. APA section headings do not use numbering. Turabian uses a numbering 

system based on the document’s structure. 

 

APA Reference List Examples 

 

(Single-author book) 

Forman, R., Jones, J., & Miller, Bruce. (2004). The leadership baton. Grand 

Rapids: Zondervan. 

 

(Book with subtitle) 

George, P. (1994). College teaching abroad: A handbook of strategies for 

successful cross-cultural exchanges. Boston: Allyn and Bacon. 

 



(Doctoral dissertation) 

Giles, G. W. (1998). The relationship of intercultural competence to ministry 

effectiveness in the Christian college context. Doctoral dissertation, Trinity 

Evangelical Divinity School. 

 

(ERIC/online document) 

Gallimore, R., et al. (1992). The developmental and sociocultural foundations 

of mentoring. Unpublished document, Columbia University, Institution for 

Urban and Minority Education, New York. (ERIC Document Reproduction 

Service No. ED354292) 

 

(Chapter in an edited volume) 

Goodenough, W. (1987). Multiculturalism as the normal human experience. In 

E. M. Edy & W. L. Partridge (Eds.), Applied anthropology in America (2nd 

ed.). New York: Columbia University Press. 

 

(Journal article) 

Granfield, R. (1991). Making it by faking it: Working-class students in an elite 

academic environment. Journal of Contemporary Ethnography, 20, 331-351. 

 

(Edited book) 

Griggs, L. B., & Louw, L. (Eds.). (1995). Valuing diversity: New tools for new 

reality. New York: McGraw-Hill. 

 

(Internet source) 

Fayetteville State University. (29 March 2006). Mentoring program survey: 

Student/Protégé. 

http://www.uncfsu.edu/univcoll/mentoring/mentoringsurveystdnt.htm: 

Fayetteville State University. English. 

 

(Unpublished work) 

Kim, Hyunwan. (2012). “Library Information Lecture Notes.” Grace University. 

 

APA In-Text Citation Examples 

In APA style, sources are cited within the text using a short parenthetical citation 

(Short Citation) rather than footnotes. Include the author’s name, publication year, 

and page number. Use (p.) for a single page and (pp.) for multiple pages. If the 

author and year have already been mentioned in the same sentence, include only 

the page number. 

 

Writing Quotations 

For quotations of three lines or fewer (or 30 words or fewer), use quotation marks 



and incorporate the passage into the body of the text. If part of the original passage 

is omitted, use an ellipsis (…) to indicate the omission. Quotations of more than 

three lines or 30 words should be formatted as a block quotation: indented 

approximately 0.5 inch from the left margin, single-spaced, with no quotation marks. 

A blank line precedes and follows the block. 

 

Short Quotation Example 

In January 1642, when the king attempted to arrest five members of Parliament, the 

voice that proclaimed “the privileges of Parliament” is well known to historians. But 

the other—very loud—voice that cried “God bless the king” is less often 

remembered. ((Insert footnote here)) 

 

Short Quotation with Omission 

“England has … [England’s own] laws which she has enjoyed for over three hundred 

years.” England’s law is uniquely its own, a fact that is “a national pride.” ((Insert 

footnote here)) 

 

Note: [ ] brackets indicate that the enclosed words are not in the original text but 

have been added by the current author for clarity. 

 

Long (Block) Quotation Example 

A block quotation begins on a new indented line (0.5 inch) and is single-spaced. No 

quotation marks are used, but a footnote must still be provided. A blank line 

precedes and follows the block. 

 

Geoffrey Chaucer recorded the following about a woman who lived in Bath in the 

fourteenth century: 

 

The Wife of Bath’s fifth husband used to read to her from a book called The 

Book of Wicked Wives. She said, ‘I had a premonition that my husband would 

read that cursed book all night. So I seized the book and tore out the page he 

was reading, and then struck him in the face so that his head fell toward our 

fireplace.’ ((Insert footnote here)) 

 

This passage illustrates one aspect of medieval womanhood. When resuming the 

main text after a block quotation, if the new paragraph continues the same thought, 

do not indent the first line. If it begins a new idea, indent as you would for a new 

paragraph. 

 



Citation Management Software: Zotero 
Because citation rules vary across styles and source types, remembering every 

formatting detail is extremely difficult. Many students find that even after completing 

their research and writing, organizing the bibliography accurately takes additional 

time and can delay or jeopardize their submission. Using citation management 

software is the most efficient and reliable way to handle this challenge. 

 

What Is Zotero? 

Zotero is a free, open-source citation management program that automatically 

formats footnotes and bibliographies. It can be downloaded and installed from 

http://www.zotero.org/download/. Once you create a free online account, your library 

can be synced to the cloud, so even if you uninstall the program or switch 

computers, your data can be fully restored by signing in and syncing again. 

 

Key Advantages 

• Integrates directly with web browsers to capture source information 

automatically. 

• Available in Korean and other languages (though some translations may be 

imperfect). 

• Completely free to use with a registered account. 

• Intuitive and easy to learn. 

 

Installation 

• Search for “Zotero” online or visit http://www.zotero.org/download/ and 

download the Zotero application. (The older name “Zotero Standalone” is no 

longer used.) 

• After installation, register for a free online account. 

• Once registered, your library will be backed up online. If you reinstall Zotero 

on any computer, simply sign in and sync to restore your entire library. 

 

My Library 

• My Library contains all your citation entries, organized into Collection folders. 

• Clicking “My Library” at the top displays all entries. 

• You can create Collection folders by subject or course: File → New Collection 

→ Enter title → OK. 

• To move an entry to a different collection, drag and drop it into the desired 

folder. 

 

http://www.zotero.org/download/
http://www.zotero.org/download/


File Menu 

New Item: Click this to add a new citation entry. A list of source types appears; 

select the appropriate type (book, journal article, website, etc.). A blank entry form 

opens in the right panel. You can edit the fields at any time. If you selected the 

wrong item type, change it using the “Item Type” drop-down. 

 

Using Icons to Add Items: The toolbar below the menu bar offers icon shortcuts for 

adding items. The green “+” button opens the same list of source types as File → 

New Item. The magic wand icon (or barcode icon) opens a field where you can enter 

an ISBN number; Zotero will then automatically retrieve and fill in the bibliographic 

information from the internet. 

 

New Note: This feature lets you save personal notes and link them to specific 

citation entries. Clicking it opens a word processor-like panel on the right where you 

can type freely. 

 

New Collection: Creates a new Collection folder for organizing entries by course or 

topic. After clicking, type a name and click OK. The new folder appears in the left 

panel under My Library. 

 

Edit Menu 

Copy Citation: Select an entry and click this option to copy the footnote-formatted 

citation to your clipboard. You can then paste it anywhere. Note: citations pasted this 

way will not be recognized by Zotero’s automatic bibliography generator. For full 

integration, use the Zotero tab in Word instead. 

 

Copy Bibliography: Select an entry and click this to copy it in bibliography format. 

Paste it at the end of your document. To choose between APA or Chicago format for 

this function, go to Edit/Tools → Settings → Export and select your preferred 

“Default Output Format.” 

 

Installing the Word Plugin and Inserting Citations 

Installing the Word Plugin: In Zotero 7 and later, the Word plugin is installed 

automatically when you install Zotero. When you open Word, you will see a 

dedicated “Zotero” tab in the ribbon. 

 

If the Zotero tab does not appear, open Zotero and go to Edit → Settings → Cite 

tab → Word Processors and click “Install Microsoft Word Add-in.” (On Mac: Zotero 

→ Settings → Cite tab.) Restart Word after installation. 

 

Inserting a Footnote: Place your cursor where you want the citation in Word, then 

click the “Zotero” tab. Click the first icon (Add/Edit Citation). The first time you do 



this, Zotero will ask you to choose a citation style. Select “Chicago Manual of Style 

17th edition (full note)”—this is equivalent to the Turabian style. A search dialog 

will then appear; search for the source you want to cite, select it, enter the page 

number in the field provided, and click OK. The footnote will be inserted 

automatically in proper Turabian format. Note: If the author’s name is in Korean, the 

formatting may need to be corrected manually. 

 

Inserting a Bibliography: Click the “Zotero” tab in Word, then click the “Insert 

Bibliography” icon. Zotero will automatically generate a formatted bibliography from 

all the sources you have cited in the document. 

 

Settings (Zotero 7+) 

In Zotero 7 and later, preferences are accessed through Edit → Settings 

(Windows/Linux) or Zotero → Settings (Mac). Key settings include: 

 

Sync: Log in with your free Zotero account to enable cloud sync. Your library will be 

available on any computer with Zotero installed. 

 

Export: Under the Export tab, you can select your Default Output Format (e.g., APA 

or Chicago) for the Copy Citation and Copy Bibliography functions. 

 

Importing Text Files into Zotero 

It is possible to import plain-text bibliography data into Zotero, though this process 

can be error-prone. Manual entry may be faster in many cases. The general process 

is: 

 

1. Register at text2bib (http://text2bib.economics.utoronto.ca/index.php/index). 

2. Convert your text file using the tool. 

3. Save the converted file. 

4. Import the file into Zotero. 

 

http://text2bib.economics.utoronto.ca/index.php/index
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